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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Overview of Recruiting Booster

What's Recruiting Booster  
Oracle Recruiting Booster increases the power of Oracle Recruiting to help organizations expand job awareness, engage
candidates at scale, and schedule interviews faster

Oracle Recruiting Booster was created to expand the capabilities of Oracle Recruiting and help organizations accelerate
hiring while building better relationships with candidates. It’s intended to be used with Oracle Recruiting and operates as
an embedded part of Oracle Recruiting and Oracle Cloud HCM.

To effectively support your talent acquisition strategy, Oracle Recruiting Booster enables your business to converse with
candidates over text and email, create a streamlined and flexible interview scheduling process, promote and manage
hiring events, and deliver guided conversational experiences to candidates through Oracle Digital Assistant.

• Two-way messaging: Enables recruiters to send and receive SMS and email-based communications with
candidates directly through Oracle Recruiting. This helps hiring teams quickly reach candidates through
their preferred channels while making interactions between recruiters and talent faster and more personal.
Communications are automatically tracked, giving recruiting teams full visibility into the engagement history
with each candidate.

• Expanded candidate interview features: Streamlines the interview scheduling process and gives recruiters
deep visibility into which interviews are taking place. Recruiting teams can view all candidate and interview
information in one centralized location. Additionally, Oracle Recruiting Booster automatically identifies ideal
times for interviews that align with the hiring team’s availability. Hiring managers and recruiters can also
request interviews to be scheduled for candidates, and other users can see the list of requests and take action
to schedule interviews.

• Hiring event promotion and support: Helps recruiters create and promote open roles and recruiting events.
This feature is built into the Oracle Recruiting job portal to make it easy for recruiters to create event listings,
registration pages, and prescreening questionnaires for specific job requisitions. Recruiters can also track
registration and attendance and use Oracle Recruiting’s built-in candidate relationship management tools to
market events to specific candidate groups.

• Expanded Oracle Digital Assistant capabilities: Empowers recruiters to communicate with candidates in a
conversational manner and from any device. New capabilities in Oracle Digital Assistant enable candidates
to search for jobs based on their preferred location, category, or job function, receive job recommendations
based on their resumes, complete job applications from the chat bot interface, and get answers to job-related
questions, and view interview schedules. Using these features, recruiters and candidates can save time and
effort on administrative tasks and communicate more efficiently.
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2  Use Hiring Events

What's Hiring Events  
Hiring events let organizations rapidly fill many open positions by expanding job awareness and engaging candidates
at scale. Events can last anywhere from a few hours to a few days, and could either drive recruitment or be purely
informational in nature. This feature helps organizations to build high quality talent pipelines.

Every hiring event has an event team comprising of one owner and several collaborators who are responsible for putting
the event together and defining its format. Once the event is ready for registration, candidates who are interested sign
up for the event to learn more about the opportunities on offer.

As an event team member you can:

• Define the event’s format, dates, and location.

• Format and preview an event before posting or publishing it.

• Select a career site for posting or publishing an event.

• Invite candidates to an event.

• Review candidate registrations.

• Send notifications to candidates regarding event activities.

• Help candidates with check-in.

• Record interactions with attendees.

• Match qualified candidates to requisitions.

• Assess success metrics of an event.

As a candidate you can:

• Receive an invitation for an event.

• Search for an event on the career site.

• Register for an event.

• Manage event registrations through a career site.

• Receive event-related notifications by emails or messages.

• Check in to an event.

• Receive information about further processing.

Once Recruiting Booster is enabled, events are visible on the Hiring module alongside job requisitions. Posted events
can be found along with jobs on the career sites, provided that events have been enabled on those sites.

Related Topics
• Set Up Hiring Events

3
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Event Phases  
An event starts with the Draft phase and passes through several phases before reaching the terminal phases of
Completed or Canceled.

Event phases are:

• Draft

• Event Setup

• Posted (public events) or Open for Registration (private events)

• Unposted (applicable only to public events)

• Completed

• Canceled

Create an Event  
Create a hiring event to fulfill the mass recruitment needs of your organization. When you create an event, you define
the framework for event owners and collaborators to manage various aspects of the event such as whether it's public or
private, the dates and location, and whether it's in-person or virtual.

Once the event is ready for registration, candidates who are interested sign up for the event to learn more about the
opportunities on offer.

1. Open the Hiring work area.
2. Click the Events tab.
3. Click Add.
4. Select one of the following:

◦ Blank - to create a brand new event. You'll need to complete all fields for this event.

◦ Existing Event - to create a new event based on an existing event. All fields are prepopulated for you based
on the event you selected, but you can make changes. If there are any prescreening and disqualification
questions, they're also copied to the new event. Events in draft or in event set-up phase can't be copied.

5. Indicate whether the event is public or private in the Event Visibility field.
A public event is open to all. A private event is by invitation only and isn't visible on a career site.

6. Enter comments in the Event Purpose field.
This field is intended for internal use, and the contents won't display to candidates.

7. Select a language.
If you believe that candidates from more than one region will attend your events, you can enable multiple languages
for the events. Once you've selected the appropriate languages, you can then manually translate certain fields for the
event using the Translate Event option in the Action menu. When the event is posted, candidates who have selected
the same language on the career site as one of the event languages will see the event translated into the language of
their choice.

8. Select the Enable interviews for this event check box to enable interviews for mass hiring events.

4
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Once enabled, the Interviewers tab displays when the event moves to the event set-up phase. The event team uses
that tab to add a set of interviewers who will interview candidates during the course of the event.

9. If you'd prefer not to use automatic approvals of candidate registrations, select the Enable manual confirmation of
registrations check box.
Candidates will see a message when they register for the event that let's them know that they'll receive a
confirmation once their registration is approved. Their status will display as Pending in My Events on the career site
until it's confirmed.

10.Complete the remaining fields for Event Information, Event Dates, Location Details, Event Team, and Attachments. In
the Locations Details section, you can define both in-person and virtual event details.

◦ In the Event Dates section, enter the last registration date information. The last registration date can't be
greater than the event end date.

◦ In the Location Details section, enter the event’s maximum capacity.

Once the last registration date has been reached, or the capacity is about to be exceeded, registrations are
automatically disabled on the career site.
Attachments are internal-facing, and not displayed to candidates.

11. Click either Save and Close or Submit.
If you click Save and Close, the event remains in Draft phase. If you click Submit, the event is moved to Event Set-Up
phase, where you'll design the Event Layout.

What to do next

• Format an Event

• Translate an Event (if you've selected additional languages)

• Preview an Event.

• Post an Event

• Invite Candidates to Events

Format an Event  
Once you've created a hiring event, you need to format it to set up the layout, event banner, event description, and
registration form. You can add event questions here if the registration form you select contains questions.

Watch video
 

1. If your event is in Event Set-Up phase, navigate to the Events page, locate the event, and open it. If your event is in
Draft phase, submit the event.

2. Click Event Page Layout.
3. Add an event banner.
4. Enter the event description.

The event information visible on the event page layout was entered during draft mode. The event description is
editable, and can be formatted. The short description is visible on the event tile as well as listings on the career sites.
The long description is visible on the event details page.

5. Click Edit and select the appropriate registration form.
If you add one containing questions, the Questions section displays.

5
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6. Click Edit and select the appropriate questions for the event registration.
Including event questions lets you gather more information from the event registrants prior to events. You can add
prescreening questions and disqualification questions. Including disqualification questions lets you automatically
reject candidate registrations based on their responses. You can rearrange the order of the questions. When an event
is an in-person event, questions are automatically filtered to those that apply only to the country in which the event
is happening. Virtual events will have a separate country selector.

7. Click Save

Translate an Event  
If you've enabled several languages for your event, you or an event member must translate the details of the event so
that they display to users in those languages.

Event users can preview the translations using the Languages drop-down list on the preview section.

When the event is posted, candidates who have selected the same language on the career site as one of the event
languages will see the event translated into the language of their choice. In addition, the check-in page for the event
will also display in their preferred language. Upon registering for the event, the candidate's language preference is
remembered and all subsequent event related notifications are sent in the candidate's preferred language.

Note:  Translations for notifications must be entered using the Translation Editor on the Recruiting Content Library, so
that event notifications can be sent in the candidate's preferred language.

Before you start

Be sure you've selected the appropriate languages while you were creating the event.

Here's what to do

1. Open the Hiring work area.
2. Click the Events tab.
3. Locate the event and open it.
4. Select Translate Event from the Actions menu.

The languages you selected in the Event Information section while you were creating the event display on the
Translate Event page.

5. Click the Edit icon next to a language.
6. Enter the event name, event long description, and event short description in that particular language.
7. Click Save and Close.

Preview an Event  
Preview how an event looks on a selected career site. You can preview updates to details, the banner image, language
choices, and the long description.

1. Open the Hiring work area.

6
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2. Click the Events tab.
3. Locate the event and open it.
4. Select Preview Event from the Actions menu.
5. On the Preview page, select a career site. If the event isn't posted, the Career Site drop-down list displays all career

sites. If it's posted, the drop-down list displays career sites to which the event has been posted or published.
Although preview for mobile devices is currently not supported all event related listings will display properly on
mobile devices.

6. Select a language to preview how the translation reads for the event.
7. Optionally, you can click the copy link icon in the event preview to copy the event URL to the clipboard, and share the

event with others.

Post an Event  
After you've formatted and previewed an event, you or another event team member can post it.

Once an event has been posted or published the Audience section appears on the event. The Audience section displays
all candidates who have been invited to, registered, or attended the event.

1. Open the Hiring work area.
2. Click the Events tab.
3. Locate the event and open it.
4. Select the Posting tab.
5. Click Edit.
6. Select one of the following from the Posting Schedule drop-down list:

◦ Do Not Post - to keep the event unposted for now.

◦ Post Now - to post the event immediately. You can also select and expiration date to have the event
automatically unposted at that time.

◦ Post Later - to repost the event at a later date. You can also select and expiration date to have the event
automatically unposted at that time.

7. Select the appropriate career sites.
The career sites that display in this list use the Minimal template, and have Events enabled.

8. Click Save.

Results:
Once posting is complete, the event is moved to the Posted phase. Private events are moved to the Open for
Registration phase once they're published to selected career sites.

Related Topics
• Unpost and Repost an Event

7
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Unpost and Repost an Event  
You can unpost a posted public event at any time. Once unposted, the event is moved to Unposted phase and won't be
visible to candidates on a career site. You can't unpost private events once they've been published.

You can repost unposted events after making any necessary changes. Once reposted, audience members who have
already registered for the event will receive an Event Update Notification alerting them to the changes. Reposted events
will once again revert to the Posted phase.

1. Open the Hiring work area.
2. Click the Events tab.
3. Locate the event and open it.
4. Select the Posting tab.
5. Click Edit.
6. Select one of the following from the Posting Schedule drop-down list:

◦ Do Not Post - to unpost the event immediately.

◦ Post Now - to repost the event immediately. You can also select and expiration date to have the event
automatically unposted at that time.

◦ Post Later - to repost the event at a later date. You can also select and expiration date to have the event
automatically unposted at that time.

7. Click Save.

Related Topics
• Event Phases

Complete an Event  
Once an event has started, the only action available is Complete Event. Marking an event as complete prevents further
changes to the event, such as adding new candidates.

Current event attendees aren't impacted when you complete an event. However, private event URLs and check-in
links are disabled and the event is removed from the list of events to which candidates can be added. Once completed,
you can't re-enable an event. You can only add attachments and move candidates from a completed event to either a
requisition or a candidate pool. Completed public events aren't automatically un-posted. This allows you to use events
that have ended for marketing purposes. You can un-post them when you no longer want them to be visible to the
public.

1. Open the Hiring work area.
2. Click the Events tab.
3. Locate the event and open it.
4. Select Complete Event from the Actions menu.

8
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Cancel an Event  
Event owners can cancel events at any point before the event start date. If candidates have already registered for an
event that you then cancel, their Registered status remains, but they'll receive a cancelation email.

Candidates will see a Canceled label on the event in their candidate self-service. New candidates can't be added to
canceled events. If an event is posted, and you cancel it, the event is automatically unposted. All event URLs associated
with a canceled event become unavailable.

1. Open the Hiring work area.
2. Click the Events tab.
3. Locate the event and open it.
4. Select Cancel Event from the Actions menu.

This action isn't available until an event has been posted.
5. Click OK to confirm.

Invite Candidates to Events  
You can invite candidates to both public events (those that are available on career sites) and private events (those that
are by invitation-only) by adding them to the specific event.

When candidates are added to events, either an email notification or SMS notification containing a registration link is
sent to them. You can invite candidates through:

• Applications from requisitions

• Candidate pools

• Candidate search

• Actions available from candidate profile which is accessible from all of the above locations

Although you might see internal employees when you filter candidates in any of these locations, you should only extend
invitations to external candidates. The external career links in the email invitations might not open for employees or
contractors.

Before you start
You must have the Manage Recruiting Event privilege.

Here's what to do

1. From any of the areas above, search for or filter for external candidates.
2. Select the candidates you want to invite.
3. Select Add to Event from the Actions menu.

9



Oracle Fusion Cloud Talent Management
Using and Administering Recruiting Booster

Chapter 2
Use Hiring Events

4. Select the event to which want the invite candidates.
Posted events, or those that are in the Open for Registration phase, are available on the drop-down list. Note that
you can only see events for which you're an owner or a collaborator. Events that are unposted, in Draft or Event
Setup phase, Completed, Canceled, or with an end date that's past won't appear here.

5. Click Save and Close.

Results:

If the candidates you added have valid email addresses and phone numbers, they'll receive an Event Invite notification,
either by email or SMS. The type sent depends on the candidate's preferred mode of communication. Once they receive
the invitation, candidates can click the Register link to open the event details page and decide if they want to register
for the event. If the candidates don't have verified email addresses or phone numbers on file, an error message displays
and the candidates aren't added to the event. This message also displays when the Send Event Invite Notification has
been deactivated or deleted.

Note:  Although event invite notification visibility can be both internal and external, event notifications are only for
external candidates.

Related Topics
• Assign Event Roles and Privileges

Candidate Registration and Self-Service for Hiring
Events  
After you've enabled events for an external career site, when candidates visit it, they can use the keyword search to
search by event name, event number, event category, and event short and long descriptions.

The event search results display the event dates and indicate whether the event is in person or virtual. Keyword and
location searches apply to both events and jobs. You can toggle between the lists of jobs and events.

Autosuggest and Filtering
Autosuggest lists events where the search term matches the event name or the event category. Suggestions for jobs
and events are listed separately under either a Jobs or Events header in autosuggest.

Candidates can also filter the events list based on:

• Event Categories - categories listed on this filter correspond to posted events. If there are no posted events for
a particular category, that category won't appear in the filter.

• Event Locations - values on this filter correspond to the locations of posted events. If there are no posted
events for a particular location, that location won't appear in the filter.

10
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• Start Dates - by default all events are sorted by the event start date in descending order, beginning with the
date farthest into the future. Candidates can further filter events by the following time frames:

◦ Next 7 Days - Events that start during 7 days from the current date.

◦ Next 30 Days - Events that start during 30 days from the current date.

◦ Greater than 30 Days - Events that start after 30 days from the current date.

Note:  Values on the filter correspond to events that are currently available on the career site. If a career site
has a combination of events that took place in the past and those that are taking place after the next 30 days,
then the only option in this filter will be Greater than 30 Days.

• Event Format - like the rest of the filters, values on this filter correspond to events which are posted on the
career site. The values which are supported on the filter are:

◦ In Person

◦ Virtual

Sorting Based On Relevance
When candidates search by keyword, the results are automatically sorted by relevance. Relevancy is calculated based on
where a search term appears for an event. For example, events with matching search terms in the event name are given
a higher placement in the results list than those with the same term in the short or long description. The order in which
relevancy is assigned is:

1. Event Name
2. Event Number
3. Event Category
4. Short Description
5. Long Description

A candidate who searches for a "QA Analyst", may find more relevance in events which have that term in the event
name, than those that randomly mention the term listed among many other items in a long description.

Note:  Note that searching on Location will return events corresponding to that location, but searching on My
Location and Postal Code is currently not supported for events and returns results for all locations.

Registration
Event details pages contain a button to register for events. When candidates click Register, they see the event
registration form that the event team selected when they created the event. The event registration flow is similar to the
job application flow.

Some events may no longer be accepting registrations. For example, once the end date, or last registration date, or the
maximum capacity is exceeded, registrations are disabled. In these instances, there's a message that states that the
event is no longer accepting registrations.

Once candidates submit the form, they're directed to the candidate self-service page. Candidates can manage their
event registrations using candidate self-service capabilities. A My Events tab displays on the candidate self-service
page. The page will always show event registrations whether a candidate logs in to a site where events are enabled or
not.

11
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Candidates who have completed their registration will appear as Registered to the event team on the Audience section
of the event.

Candidates can use candidate self-service to view the events they've registered for under Active Event Registrations. If
needed, they can withdraw from them by clicking the drop-down next to Status. Once a candidate withdraws from an
event:

• The registration is listed under Inactive Event Registrations (Events that have passed their end dates are also
displayed in this section)

• Candidate status is listed as Withdrew Registration on the audience section of the event

• Event capacity is freed

The candidate self-service page also lets candidates to track the registrations that they've yet to confirm. This happens
when a new candidate submits the registration form, but closes the window without authenticating their identity.

Note:  Unconfirmed candidates won’t be counted toward the event’s capacity. When they sign back into the self-
service page they'll see a Confirm action to confirm their registration. Once clicked, the candidate registration is
confirmed if the event’s capacity hasn't been exceeded.

Confirm Event Registrations Manually  
Event owners can manually manage candidate registrations and approve them based on certain criteria, instead of
using automatic approvals. This lets them focus on suitable candidates for events.

1. While creating a new event, or editing an existing one, select the Enable manual confirmation of registrations
check box in the Event Information section.
When candidates register for the event, they'll see a message that says they'll receive a confirmation once their
registration is approved. Their status will display as Pending in My Events on the career site until it's confirmed.

2. Navigate to the audience page for the event, and look for pending candidates.
3. If you feel a candidate is a good fit for your event, select the action menu next to them, and click Confirm

Registration. If you don't want to confirm the candidate, don't select the option.
Once confirmed, the candidate's status displays as Registered in My Events on the career site. They'll also receive a
confirmation email.

Copy an Event Check-In URL  
You can copy an event check-in URL and provide it to candidates so that they can check in to the event. This check-in
URL will be available for copying once an event has been posted.

You can provide this URL using email, chat, or by putting it on a kiosk.

1. On the Events page, search for and select an event.
2. On the Overview tab, select Copy Check-In URL from the Actions menu.
3. Paste the URL in the appropriate location.

12
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Related Topics
• Candidate Registration and Self-Service for Hiring Events

Candidate Check-In  
Candidates can check themselves into an event using a check-in URL.

There are several ways you can do this.

• For in-person events, you can load the check-in URL onto a kiosk on the day of the event.

• For virtual events, you can share the check-in URL with candidates using the chat feature of your virtual
meeting platform.

• You can create an event email template that contains the check-in URL (the check-in URL token can be used
${EventCheckinDeepLinkURL}), and share it with candidates using the Send Message functionality.

When a candidate opens the URL or encounters it at a kiosk, they simply enter their registered email address or
registered mobile number, and click Check In.

If for some reason a candidate's email address isn't recognized, they're presented with another link that they can copy
and use to register. Once registered they can return to the check-in URL, and check themselves in. The register link isn't
clickable. Candidates will have to enter it on their mobile device to reach it.

Once checked in, a candidate's information is cleared from the URL, so that if they're at a kiosk at an in-person event,
the next person in line can check themselves in without seeing the previous candidate's email address.

Candidates who have completed their check-in will appear as Attended to the event team on the Audience section of
the event.

Related Topics
• Copy an Event Check-In URL

Record Candidate Interactions  
Record the interactions with candidates that happen during an event. Interactions are stored on the candidate profile for
easy reference later.

When you access candidates from the candidate search, event interactions are available along with other recorded
candidate interactions. You can filter candidates at an event based on the nature and date of the interaction.

1. On the Events page, search for and select an event.
2. Click the Audience tab.
3. Search for and select the candidate.
4. Click the Interactions tab on the candidate's profile.
5. Select With Audience Member from the drop-down list and click Add.
6. Select the type that signifies the nature of the interaction with the candidate.
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7. Enter the appropriate information and click Save and Close.

View Candidate Question Responses  
As an event owner, you can view audience member responses to the questions associated with an event's registration
form.

1. On the Events page, search for and select an event.
2. Click the Audience tab.
3. Search for and select a candidate.
4. Click the Questions tab on the candidate's profile.
5. Filter by question type.

Filter Candidates by Answers to Prescreening Questions  
Event owners can filter candidates based on the responses they've provided to prescreening questions.

1. On the Events page, search for and select an event.
2. Click the Audience tab.
3. Expand the Question and Answer filter, and open it to display all available questions and answers for the event.
4. Select a question and answer to display a subset of candidates.

If there are multiple choice questions with multiple possible answers, you can filter candidates based on their answer
to that question.

Send Personalized Messages to Audience Members  
Event pool member notifications are customized, personal messages that you can send before and throughout
an event. For example, you might want to send event reminders or announcements that lunch is being served in a
particular room.

A best practice is to work with your recruiting administrator to set up and customize all of the various event pool
member notifications you plan to send for the event before the event start date.

It's also possible to customize these messages for use as SMS messages. The type of message sent depends on the
candidate's preferred mode of communication.

1. On the Events page, search for and select an event.
2. Click the Audience tab.
3. Select the candidates you want to message.
4. Select Send Message from the Actions menu.
5. Click Continue.
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6. Select the use.
7. Select the message template.

If you have multiple message templates set up, they'll all display here. Alternatively, you can create a message from
scratch by selecting Blank Message from the Use drop-down list.

8. Select an email type from the Design drop-down list.
Only ad-hoc email type templates configured in the Manage Email Templates section in the Setup and Maintenance
work area appear here.

9. Click Continue.
10.Update the message if necessary.
11. Click Continue to preview the message.
12. Click Send. A confirmation message displays letting you know that your message was sent to your audience

members.
Another way you can send personalized messages to candidates is to filter for certain candidates on the Audience
page, and send individual messages to them by clicking Send Message from the actions menu. For example, you
can filter for an event's audience members who were Invited to Attend, but have yet to register for an event. You
can then send a message to each candidate in that list to encourage them to do register. Messages sent to specific
candidates are recorded on the corresponding candidate's profile.

Replies from candidates to the received email or SMS messages are recorded on the Messages tab.

Related Topics
• What's Two-Way Candidate Messaging

• Configure Event Related Notifications

Event Success Metrics  
You can analyze hiring event success using metrics that detail the total number of registrants, attendees, and
candidates who have been matched to requisitions, applied for open positions, or were hired as a result of attending the
event.

Metrics display on the Overview tab throughout the event lifecycle, and you can use them to evaluate the success of the
event. Depending on what phase the event is in, you may see:

• Invited - the number of candidates invited to the event. This metric only displays for private events.

• Registered - the number of candidates who registered for the event.

• Attended - the number of candidates who attended the event. This number consists of those who checked in
using the check-in URL.

• Shortlisted - the total number of candidates for whom the Shortlisted setting is set to Yes. This metric displays
for events that have interviews enabled, and shows data as soon as interviewers begin shortlisting candidates.
The number may continue to change until an event ends.

• Matched to Requisitions - the number of candidates who were matched (added) to requisitions from an event.
A candidate can be matched to multiple requisitions, but they will only be counted once for this metric.

• Applied Within - the number of candidates who applied within 30 days of the event start date. This metric is set
to 30 days by default, but is configurable.

• Hired Within - the number of candidates who were hired within 90 days of the start of the event. This metric is
set to 90 days by default, but is configurable.
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Note:  Both Applied Within and Hired Within metrics are tallied based on the event start date, and includes
both the timeframe of the event plus the number of days indicated for your measurement. For example, if
the event lasts 2 days and you're measuring successful hires within 30 days, the actual length counted for the
Hired Within metric is 32 days.

Candidates must be audience members to be counted in the Hired Within or Applied Within metrics. They can be in
any state (Invited to Attend, Registered, Attended) as long as they're attached to the event.

Adding an event audience member as a prospect isn't counted toward the Applied Within metric. The audience
member must have an application or you can create a manual application for the candidate to have them count toward
the Applied Within metric.

The Applied Within metric is a count of the number of people who have applied for requisitions and not the number of
applications placed for requisitions from that particular event. This means even if an audience member applies for more
than one requisition, the candidate is only counted once in the Applied Within metric.

Candidates who apply outside of the metrics assessment window don't count toward the metric. For example, if
a candidate applies 33 days after an event ends, and you're measuring application success based on 30 days, the
candidate won't be added to the Applied Within metric. However, if they're hired within the Hired Within metric
window, they will be counted there.

Once a candidate has moved to the HR phase on a requisition, they're considered hired.

If a candidate later declines an offer, the metrics are decremented only if they decline during the assessment period

If you change the default number of days for either of these metrics, it only affects new events going forward. Previous
and current events aren't re-calibrated using the new number of days. They continue to use the old durations for
calibrating their metrics.

Related Topics
• Configure Event Success Metrics

Match a Candidate to a Requisition  
Build talent pipelines by matching qualified candidates from the event to open requisitions and candidate pools. When
you add a candidate from an event to a requisition, it's called Candidate Matching.

1. On the Events page, search for and select an event.
2. Click the Audience tab.
3. Filter for candidates who have either been invited, registered to, or attended an event using one or more filtering

criteria.
Alternatively, you can search the audience list with the candidate name and candidate number.

4. Select Add to Requisition.
5. Select the requisition you want the candidate to be added to either as an applicant or as a prospect.

The list only displays requisitions that you'ave access to (access privileges are also enforced while adding candidates
to pools from the event).

6. Click Save and Close.
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Results:
The Matched Count is updated.

Shortlist Event Candidates  
You can set up hiring events so that a set of interviews can capture comments about candidates and shortlist them for
requisitions. Event managers can then review these candidates and match them to job requisitions.

1. Add Interviewers to an Event. Event team managers enable interviews for events and add the appropriate users as
interviewers.

2. Shortlist Candidates at Events. The designated interviewers meet with candidates during the event, and use a
shortlisting form to indicate which candidates are best suited for open roles.

3. Review Shortlisted Candidates. Event team members review who's being shortlisted during the events.

Add Interviewers to an Event  
You can designate one or more people to act as interviewers for an event. Interviewers are responsible for speaking to
candidates at events, and shortlisting those who should move forward in hiring process.

Watch video
 

1. Create an event and select the Enable interviews for this event check box.
2. On the Interviewers tab, select the users you want to act as interviewers for the event.

You can add and remove interviewers up until an event starts. Interviewers can either be permanent or contract
employees of your company, and don't necessarily need access to Hiring Events in order to interview a candidate.

3. Click Save.

Results:
Once an event is posted, the interviewers you've selected will receive a link to a shortlisting form either in an email
message, or in a notification message on the bell icon. You can resend the link to the shortlisting form at any time after
the event begins by selecting Resend Shortlisting Form from the actions menu on the Interviewers page.

Related Topics
• Create an Event

Shortlist Candidates at Events  
Designated event interviewers can shortlist candidates once they check in to an event. Interviewers will receive a link to
an event shortlisting form, either through the notification bell icon, or email. The purpose of the shortlisting form is to
give interviewers a place to quickly indicate whether they think the candidate should move on to the next stage of the
hiring process.

Interviewers will be able to shortlist candidates once they check in to an event.
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Note:  Prior to the day of the event, interviewers won’t see any candidates on the shortlisting form.

A likely scenario is that on the day of an event a candidate checks-in and is guided to the appropriate interviewer by an
event team member. The interviewer selects the candidate's name from the shortlisting form, which gives them access
to the candidate's resume and cover letter.

Note:  If interviewers close the shortlisting form, they can come back to it through the link they received in the
notifications or email. When they relaunch the shortlisting form, they can pick up where they left off. All of the data
they previously submitted is intact.

Watch video
 

1. Click the link to the shortlisting form.
2. Select the candidate’s name. If there are multiple candidates with the same name, interviewers can use the

candidate's registration date as a method for selecting the correct candidate from the list.
3. Download and review the candidate’s attached resume and cover letter if they’re attached.
4. Interview the candidate, and indicate whether they’re shortlisted by selecting Yes or No.
5. Optionally, add some feedback comments.
6. Click Submit.

Results:

The candidate's information moves to a new section called Submitted Responses, and the interviewer moves on to the
next candidate.

A candidate for whom a response has been submitted will automatically disappear from the candidate drop-down list so
that no other interviewer can mistakenly select and enter feedback for the same candidate.

Once submitted, the event team instantly sees interviewer feedback on the Audience page. Interviewers can edit their
feedback if necessary and that information is updated instantly for the event team.

Review Shortlisted Candidates  
Event team members can begin reviewing shortlisted candidates on the Audience page as soon as interviewers submit
their feedback. At the end of event, all the shortlisted candidates can be filtered and matched to requisitions for offer
processing.

Watch video
 

1. On the Events page, search for and select an event.
2. Click the Audience tab.
3. Use the Shortlisted filter to see who was shortlisted and who wasn’t. A Yes or No flag appears for candidates if

an interviewer has submitted feedback. If a candidate doesn't have a Yes or No flag for Shortlisted, it means they
probably haven't been interviewed yet. The event team can also filter feedback by Interviewer.

4. Click a candidate’s name to view their profile information and see interviewer comments.
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Related Topics
• Event Success Metrics

• Match a Candidate to a Requisition

• Send Personalized Messages to Audience Members

• Copy a Job Offer
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3  Use Candidate Interviews

View and Manage My Interviews  
As an interviewer, you can view your scheduled interviews and take action on them, regardless for which requisition the
interview is.

Before you start
You need the Access My Candidate Interviews and Feedback privilege.

Here's what to do

1. Click the Interviews quick action available under Me > Interviews.
2. Click the My Interviews tab.

A calendar showing scheduled interviews for which you’re an interviewer is displayed.
3. Click Show Filters to filter the interviews by their status.

A color code is used so you can easily see the different statuses of the interviews: Scheduled, Accepted, Declined,
Tentatively Accepted.

4. Click on an interview to view its details.

View Scheduled Interviews for My Requisitions  
As an interview coordinator, you can view and manage interviews for requisitions on which you’re part of the hiring
team.

In the Scheduled Interviews tab of the Coordinator Interviews work area, you can use the filter Interview Participation.
Two options are available:

• Schedule owner on requisition: When you select this option, interviews for requisitions where you own at least
one interview schedule are listed.

• Part of hiring team: When you select this option, interviews for requisitions where you’re part of the hiring team
are listed. You can be part of the team as hiring manager, recruiter, or collaborator regardless of the collaborator
type.

Note:  Interviews matching both options are displayed by default.

Candidate Schedule Based on Interviewers Availability  
As an interview coordinator, when you create a candidate-managed interview schedule, you can select a setting called
"Candidates schedule based on interviewers’ availability". The interviewers' availability from their Microsoft 365 calendar
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is used to automatically find times where all interviewers are available, instead of forcing interview coordinators to find
times when interviewers are available.

When you select the "Candidates schedule based on interviewers’ availability" setting, you need to provide additional
info to complete the configuration:

• Set the meeting duration.

• Select interviewers. You can select specific people, or Hiring Team members such as the hiring manager,
recruiter, collaborator types.

• Set the interview visibility.

Note:  The setting "Candidate can see future interviews" is automatically selected.

When you select the "Candidates schedule based on interviewers’ availability" setting, you can't add interview slots to
the interview schedule. The application will only propose slots according to the interviewers' availability. However, you
can still schedule ad-hoc interviews on such schedules.

To determine available interview slots, the interviewer's work hours and work week configuration in Microsoft 365
are considered and only slots during these work hours are proposed. If an interviewer doesn't have a Microsoft 365
Calendar account (where we consider the interviewer as always being available and we don't know the work hours for
this interviewer), only slots between 6 AM and 9 PM are proposed. For interviewers with an Microsoft 365 Calendar
account, there is no time restriction, only the work hours of the interviewer are considered.

For the interviewers' availability to be determined correctly, the time zone of the interviewers in HCM must be set to
the same time zone used in Microsoft 365. Otherwise, the working hours configuration in Outlook won't be interpreted
correctly by Oracle Recruiting.

The reminders functionality that you can configure on candidate-managed interview schedules will work when you
select the "Candidates schedule based on interviewers’ availability" setting. Reminders can be sent to the interview
schedule owner if there is no or limited slots to be proposed to candidates for the interviewers selected on the schedule.

Candidate Experience
When external or internal candidates are responding to an interview invite to self-schedule an interview, if the interview
schedule is configured to use Microsoft 365 Calendar availability, the list of proposed time slots are based on the
interviewer’s availability in their Microsoft 365 Calendar. The list of available time slots are calculated dynamically based
on:

• The interviewer’s calendar status. A time slot is proposed only when all interviewers are free. An interviewer is
considered to be free if one of the following criteria is met:

◦ There is no calendar event during the time slot's duration (start time + meeting duration).

◦ There is a calendar event during the time slot's duration (start time + meeting duration), but the status of
the calendar event is set to Free.

◦ Interviewers are considered as being always available if they don’t have an Microsoft 365 Calendar
account.

• The interviewer's work hours and work week configuration in Outlook. A time slot is proposed only if it fits
within the work hours and work week of all interviewers.

If no time slots are available to be proposed to a candidate, a message is displayed inviting the candidate to contact the
recruiter.
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When a candidate self-schedules an interview, the schedule owner is the meeting organizer if no meeting host was
selected (selecting a meeting host is only possible when using the Teams integration). If a meeting host is selected, this
meeting host is the meeting organizer.

Overlapping Time Slots for Automated Scheduling
When candidates are scheduling interviews for a schedule that uses the automated scheduling (the "Candidates
schedule based on interviewers' availability" setting is selected on the schedule), time slots with different start times
are available to provide several choices to candidates. This means that overlapping time slots might be proposed to
candidates. If the meeting duration is 30 minutes or less, the application will propose time slots with a start time interval
matching the actual meeting duration.

Meeting Duration Examples of Proposed Time Slots

15 minutes 8AM, 8:15AM, 8:30AM, 8:45AM, etc.

30 minutes 8AM, 8:30AM, 9AM, 9:30AM, etc.

If the meeting duration is 45 minutes or more (45 min, 1 hour, 2 hours, 3 hours, 4 hours, 6 hours, 8 hours, etc.), time
slots with a start time interval of 30 minutes are available.

Meeting Duration Examples of Proposed Time Slots

45 minutes 8AM, 8:30AM, 9AM, 9:30AM, etc.

1 hour 8AM, 8:30AM, 9AM, 9:30AM, etc.

2 hours 8AM, 8:30AM, 9AM, 9:30AM, etc.

Here’s are some examples.

Example 1: An interview schedule is configured with a meeting duration of 1 hour. The interviewer's calendar for a
given day is completely booked with meetings, except for 1 block from 1:30PM to 2:30PM. For this day, one time slot is
proposed to the candidate, from 1:30PM to 2:30PM.

Example 2: An interview schedule is configured with a meeting duration of 1 hour. The interviewer's calendar for a given
day is completely free, and the interviewer's work day starts at 8AM. For this day, time slots are proposed to candidates,
starting at 30 minutes intervals: 8AM, 8:30AM, 9AM, 9:30AM, 10AM, 10:30AM, and so on.

When a candidate schedules an interview using a proposed time slot, the application also ensures that two candidates
don't select time slots overlapping each other. For example, if the meeting duration is 1 hour:

• Proposed time slots for candidate A are 8AM, 8:30AM, 9AM, 9:30AM, 10AM, 10:30AM

• Candidate A schedules interview at 8:30AM

• Proposed time slots for candidate B will be 9:30AM, 10AM, 10:30AM

The application also validates that the interviewers are still available for that time slot before scheduling the interview.
This is to prevent having two candidates schedule an interview with the same interviewers at the same time. If a time
slot is no longer available, the candidate will be asked to select a different time slot.
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Related Topics
• Create an Interview Schedule

Request Preferred Availability From Interviewers  
As an interview coordinator, you can ask interviewers to set their preferred availability for interviews.

Before you start

• The job requisition must be in the Approval phase or later phases.

• You need a candidate managed interview schedule.

• You need the Manage Job Requisition Interview Schedule privilege.

Here's what to do

1. On the Job Requisitions page, open a job requisition in the Approval phase or later phases.
2. Click the Interviews tab.
3. In the Interview Schedules section, click Add then select Create Interview Schedule.
4. Fill the Basic Information and Location Details section.
5. In the Settings section, select the setting Candidates schedule based on intervier's availability.
6. Set the meeting duration.
7. Select interviewers.

This includes both named users and hiring team member types.
8. Select the setting Request preferred availability from interviewers.
9. Click Save and Close.

Results:
A notification is automatically sent to interviewers selected on the schedule. The notification explains to the
interviewers that they’ve been identified as an interviewer for a requisition and they're invited to update their availability,
if needed.

Related Topics
• Set My Preferred Availablity for Interviews

• Create an Interview Schedule

Set My Preferred Availablity for Interviews  
As an interviewer, you can decide when you're available for candidate interviews. You might be requested to define your
preferred availability when a new interview schedule is created on a requisition or when a shared schedule is added on a
requisition.

Before you start
You need the Access My Candidate Interviews and Feedback privilege.
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Here's what to do

1. Click the Interviews quick action available under Me > Interviews.
2. Click the My Availability tab.
3. Click Edit to set your preferred availability.

◦ Use my Microsoft 365 calendar availability: This is the default option.

◦ Use both my preferred availability and my Microsoft 365 calendar availability: With this option, you can
define your availability for each day of the week. You can change your availability at any time.

4. Click Save.

Results:
When time slots are proposed to candidates invited to schedule an interview on a candidate managed schedule that
uses automated scheduling (the "Candidates schedule based on interviewers' availability" setting is selected), both
calendar availability from Microsoft 365 and your preferred availability are considered. For a given time slot to be
proposed to candidates, you must be available in both places (your preferred availability and Microsoft 365).

Request Interviews to be Scheduled for Candidates  
As a hiring manager or recruiter, you can request interviews to be scheduled for candidates. Interview coordinators then
review the list of requests and take action to schedule interviews.

You can request interviews to be scheduled for one or several job applications. When you select 1 to 10 job applications,
the Request Interview to Be Scheduled action is done in real time. If at least one job application is processed
successfully, a confirmation message appears indicating that the action was successful. When you select more than 10
job applications, the action is done asynchronously, as a batch. You receive a notification when the action is completed.
You can view details about the number of job applications that were processed successfully and those that failed.
The Request Interview to Be Scheduled action isn’t available for job applications that are in the states Withdrawn
by Candidate and Rejected by Employer and those in the HR phase. The action is also not available when the job
requisition is filled, canceled, or suspended.

Before you start
You need the View Candidate Job Application privilege.

Here's what to do

1. Open a job application.
2. In the Actions menu, select Request Interview to Be Scheduled.
3. Enter details about the interview.

◦ Scheduling Coordinator: You need to select an interview coordinator.

◦ Interviewers: Select interviewers.

◦ Format: Select the format of the interview: In person, by phone, or using web conference.

◦ Meeting Duration: Indicate the time required for the interview.

◦ Scheduling Notes: Provide any additional info.

4. Click Submit.

Results:
A notification is sent to the interview coordinator assigned to the request. To view the list of interview requests and
scheduled interviews, the interview coordinator goes to the Coordinate Interviews work area.
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Change Duration and Interviewers When Sending an
Interview Invitation  
As a hiring manager or recruiter, when you invite a candidate to schedule their own interview for a requisition, you can
modify interview details such as the duration of the interview and the interviewers.

Before you start

• You need to select a single candidate-managed interview schedule within the Send Interview Invite page.

• The setting "Candidates schedule based on interviewers' availability" must be enabled for the schedule.

Here's what to do

1. Open a job application.
2. In the Actions menu, select Send Interview Invite.
3. Select the interview schedule.
4. Click Edit to change the interview details.

You can change the duration of the interview and the interviewers. These changes will only be made for this
interview invite. It won't change the interview schedule.

5. Click Save.

Results:
When candidates access their self-scheduling page, they will see a list of proposed interview times based on the new
meeting duration and interviewers.

Coordinate Interviews  
As an interview coordinator, you can view and manage interview requests, you can see your scheduled interviews,
foresee upcoming interviews, and see interviews on which you're also an interviewer.

A quick action called Coordinate Interviews is available under My Client Groups > Hiring.

Note:  You need the Coordinate Candidate Interviews and Feedback privilege to access the Coordinate Interviews
work area.

The page displays information into 4 tabs:

• Interview Requests: As an interview coordinator, you can view a list of interview requests created for you. Each
request displays the candidate name and number, the requisition name and number, the request status, the
name of the person who created the request, and the date of the request. You can filter the list of requests.
You can click on a request to view its details and send an interview invite. You can also delete the request and
change the request status.

• Scheduled Interviews: You can see a calendar displaying all the interviews for requisitions on which you own
an interview schedule. Use filters to display scheduled interviews by their status, requisitions, candidates, and
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interviewers. A color code is used so you can easily see the different statuses of the interviews. Click on an
interview to see interview details, interviewers, and candidates who will be interviewed.

• My Interviews: You can see a calendar showing scheduled interviews for which you're the interviewer. You
can filter the interviews by their status. A color code is used so you can easily see the different statuses of the
interviews.

• My Availability: You can define when you're available for candidate interviews.

Manage Shared Interview Schedules  
As an interview coordinator, you can create shared interview schedules which can be used on multiple job requisitions
to prevent having to create similar interview schedules for each requisition.

A quick action called Manage Shared Interview Schedules is available under My Team > Hiring and My Client Groups >
Hiring.

Note:  You need the Manage Job Requisition Interview Schedule privilege to access the Manage Shared Interview
Schedules work area.

From the Manage Shared Interview Schedules page, you can view a list of shared interview schedules. By default, the
list is filtered to show active and published schedules. It's also sorted by last modified date, from the most recent to the
oldest. You can quickly view if the schedule is used or not in requisitions.

When you click on a shared schedule, you can view the details of the schedule such as interview slots, associated
requisitions, schedule type, location details, settings.

You can create a shared interview schedule. You can create a shared schedule using a template or create it from scratch
using a blank form. When you’re done creating the shared schedule, it’s automatically activated.

For each shared interview schedule, you can use different actions such as Inactivate Schedule, Translate Schedule,
Duplicate Template. When shared schedules are created and activated, hiring managers or recruiters can add them to
job requisitions.
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4  Use Two-Way Candidate Messaging

What's Two-Way Candidate Messaging  
Two-way candidate messaging enables recruiters and hiring teams to send and receive SMS and email-based
communications with external and internal candidates directly through Oracle Recruiting.

This helps hiring teams quickly reach candidates through their preferred channels while making interactions between
recruiters and talent faster and more personal. Communications are automatically tracked, giving recruiting teams full
visibility into the engagement history with each candidate.

Have Conversations with Candidates Using Email and
SMS  
If your organization enabled Two-Way Communication, you can create an email or text message to start a conversation
with an external or internal candidate about their job applications, interviews, job offers, or have any casual conversation
with them.

A Messages tab is available in candidate job applications, prospect records, candidate profiles, candidates in candidate
pools. The tab contains two sections:

• Emails

• Text Messages

You can create an email or text message to start a conversation with a candidate. You can reply to an existing message
to all message participants. You can also initiate a conversation or reply to a conversation from Oracle Cloud Recruiting
or you own email application (such as Microsoft Outlook, Gmail, Mozilla Thunderbird). All messages across system
such as job application confirmation, invitation to apply, interviews, job offers, are tracked as part of the Two-Way
Communication.

Consider this info about emails:

• To receive emails, candidates must have set email as their preferred communication channel. If the internal
candidate doesn’t have a work email, the alternate email is automatically used.

• If you have the appropriate privileges, you can view candidate communications and reply to them even when
you're not part of the original conversation. The new and existing participants will receive emails going forward.

• Candidates can initiate an email conversation as long as they know the company’s vanity email address.

◦ If the candidate is available in Oracle Recruiting, that communication is saved as part of the candidate's
profile. The Hiring team can later reply to that candidate communication from Oracle Recruiting.
Note that this communication can’t be attached to any job application as there is no context to that
communication initiated by the candidate.

◦ If the incoming email isn't associated to any candidate, then the message is simply discarded.

• The Two-Way Communication is designed to facilitate 1-1 conversations between the Hiring team and the
candidate. Thus, bulk actions to send communications to multiple candidates isn't supported.

29



Oracle Fusion Cloud Talent Management
Using and Administering Recruiting Booster

Chapter 4
Use Two-Way Candidate Messaging

• Conversation threads are ordered by the latest reply. Within the threads, messages are ordered by the latest
date. Reply functionality is available per thread.

• When a prospect is converted into a job application, we will copy the messaging headers and will link to the
latest (job application) interaction once there is a reply on any of the emails on the thread by the recruiter or
candidate.

• Any attachments sent by the candidate in the email are ignored and discarded.

• All the URLs will be shown as text within the message preview. You can copy the URL text and navigate to it in a
separate browser window. The URL hyperlink, however, will be shown on the Reply message text.

Consider this info about text messages:

• To receive text messages, candidates must have set phone as their preferred communication channel.

• Job requisition security can’t be applied to text messages. As a result, any user having access to a candidate
profile can view text messages sent to the candidate or received from the candidate.

• Text messages aren't attached to job applications.

• The incoming text messages will be read right from the time when the Two-Way Communication is enabled.

Compose an Email  
You can compose an email to start a conversation with a candidate about their job applications, interviews, job offers, or
have any casual conversation with them.

You can compose an email from a candidate job application, prospect record, candidate profile, and candidate in
candidate pools. To compose an email, the candidate must have set email as their preferred communication channel.
Let's say you're in a candidate job application.

1. In the candidate application, click the Messages tab.
2. In the Emails section, click Compose.
3. On the Compose Email page, complete these fields:

a. To: The list of emails is automatically filled by the system. You can’t change nor add participants.
b. Subject: Enter a subject for the message.
c. Email Text: Enter the message. You can use the editor to format the text. Note that images aren't supported.

4. Click Send.

Results:
The message appears on the Messages tab, in the Emails section.

Compose a Text Message  
You can compose a text message to start a conversation with a candidate about their job applications, interviews, job
offers, or have any casual conversation with them.

You can compose a text message from a candidate job application, prospect record, candidate profile, and candidate in
candidate pools. To compose an SMS, the candidate must have set phone as their preferred communication channel.
Let's say you're in a candidate job application.
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1. In the candidate application, click the Messages tab.
2. In the Text Messages section, click Compose.
3. On the Compose Text Message page, enter the message.
4. Click Send.

Results:
The text message appears on the Messages tab, in the Text Messages section.

Notifications for Candidate SMS Replies  
Hiring team members are notified through email as soon as candidates reply to their SMS messages. This applies even
they send SMS messages from the candidate’s profile or through candidate pools and receive replies from candidates.

An email notification contains a deep link that takes the recipient to the Messages tab in Recruiting.

Email notifications are based on a content template, which is available in the Recruiting Content Library in the Setup and
Maintenance work area:

• Content Item Name: Email Notification To Hiring Team for Incoming SMS

• Category: Hiring Team Notifications For Incoming Candidate Messages

• Code: ORA_INBOUND_SMS_NOTIFICATION

Email notifications are sent in real-time using the Webhook functionality, which has the capability to read incoming
SMS messages instantaneously from the SMS provider. The existing scheduled process, Process Recruiting Inbound
Message, also reads and processes incoming SMS messages, but it runs once in 15 minutes. Webhook addresses this lag
time by processing messages instantaneously.

Note:  Even though the Webhook functionality is available, it’s recommended to run the scheduled process to offset
any Webhook sync issues that may occur due to unavailability of the application or a spike in application usage.

An SMS conversation initiated by a hiring team member is considered active for a specific duration configured by the
administrator. When a candidate replies to the SMS during the active conversation period, an email notification is sent
to the recruiter, hiring manager, or collaborators, or to all of them, depending on the configuration settings.

Notifications for Candidate Email Replies  
Hiring team members are notified through email when candidates reply to an auto-generated email sent from a vanity
ID that's set up in Recruiting.

When a candidate replies to an email related to a job application, prospect, or referral, the recruiter and hiring manager
on the job requisition are notified. For emails related to candidate pools, the pool owner is notified. The hiring team
can view the reply from the candidate in the Messages tab of a job requisition. They need to select the option, With
Candidate for This Application, from the drop-down list in the Emails section. You need to run the scheduled process,
Process Recruiting Inbound Messages, to deliver these incoming emails from candidates to the hiring team.
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Note:
• When a candidate replies to an auto-generated email sent from a no reply email ID, hiring team members

won’t be notified. In the content library, when the Capture Message check box is disabled for an automated
notification, the email will be sent through the no reply email ID. If this check box is enabled, then emails are
sent from the vanity email ID, and hiring team members are notified of any candidate replies.

• Emails related to job alerts, campaigns, or candidate verifications containing the PIN number are usually sent
through the no reply email ID. If candidates reply to them, hiring team members won’t be notified.
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5  Use Recruiting Assistant

What's Recruiting Assistant  
Oracle Recruiting Assistant (ORA) is a 24/7 chat bot that helps candidates find the right jobs, get answers to their
questions, view job recommendations based on their resumes, check job application status, and receive contextual
guidance at the right time. It empowers recruiters to communicate with candidates in a conversational manner and from
any device.

ORA supports these three skills:

• Candidate Experience

• Internal Candidate Experience

• Hiring

Candidate Experience
The Candidate Experience skill serves external candidates and has been enhanced with new capabilities, making it the
Candidate Experience Version 2 (CE V2) skill. It is delivered as part of the Candidate Experience V2 Digital Assistant.

When you opt in to Recruiting Booster, you get expanded capabilities as part of the CE V2 skill.

The Expanded CE V2 Capabilities

These expanded capabilities enable candidates to search for jobs based on a specific location, job category, or job
function, receive job recommendations based on their resumes, complete job applications within the chat bot interface,
and get answers to job-related questions that they may have. These capabilities are available in addition to the existing
Candidate Experience capabilities.

With these expanded capabilities, candidates can make informed decisions and experience an improved job application
process. The recruiting team also benefits from these capabilities by having more qualified candidates due to the
prescreening process, and saving time when ORA engages candidates and answers their job-specific questions.

With this enhanced skill:

• Candidates find the right jobs quickly and express interest on any device.

• Candidates ask any question they have on the job and find relevant answers, reducing turnaround time.

• Candidates can get quick job recommendations, apply for the job directly from the chatbot, and view upcoming
interview schedules.

• After applying for a job, candidates can know the status of their job application, withdraw their application, or
join a talent pool to get regular updates on potential roles.

Internal Candidate Experience and Hiring Skills
The Internal Candidate Experience and Hiring skills serve employees and are delivered as part of FADigital Assistant.
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The Internal Candidate Experience skill enables internal candidates to search for jobs, check their application status, or
withdraw their application. In release 24A, the skill has been enhanced with these new capabilities, making it the Internal
Candidate Experience V2 (ICE V2) skill:

• Enhanced job search using location, job category, and job function synonyms.

• Ability to view interview schedules.

• Ability to access help and exit the conversation at any time.

To take advantage of these new features, you must install or update FADigitalAssistant, which includes the ICE V2 skill.
You also need to enable Opportunity Marketplace.

The Hiring skill enables recruiters and hiring teams to check the status of their requisitions, the status of candidates'
applications, and review any pending offers. They can also create a new job requisition based on their hiring needs.

For detailed information on the Internal Candidate Experience and Hiring skills, refer to the Using Oracle Digital
Assistant to Interact with HCM guide.

Related Topics
• Opt in to Recruiting Booster

• Set Up Recruiting Assistant

External Candidates  

External Candidates - Search for Jobs Using QR Codes  
Candidates can scan a QR code to view the jobs they want to apply for. The recruiting team generates a QR code for a
specific set of jobs and publishes it. When the candidate scans the QR code, the Candidate Experience page opens in
the browser, with the Recruiting Assistant displaying the list of jobs that pertain to the QR code.

Candidates can then browse through those jobs and apply to the ones they’re interested in.

Related Topics
• Generate and Download a QR Code

External Candidates - Match Jobs Using Resume  
Candidates receive job recommendations based on the skills and titles specified in their resume.

When searching for jobs, they can click the Match Jobs Using Resume button to find jobs that match their skills and
titles.

The Recruiting Assistant asks them to upload their resume and then shows the relevant jobs. Candidates can then
further refine the jobs based on their location, as required.
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To use this feature, you need to complete these prerequisites:

• Enable Attachments in the Chat Interface

• Enable the Profile Import Partner Service

Intended user: External candidate

Sample phrases to use:

• Match using resume

• Find jobs based on resume

• Jobs using resume

External Candidates - Apply to Jobs Using Easy Apply  
When candidates find a job that matches their preferences, they can apply for it using the Recruiting Assistant. They can
apply to certain jobs directly from the chat bot instead of navigating to the career site. The Recruiting Assistant can also
generate a work summary based on their resume using AI Assist and attach it to the job application

These capabilities are available when an easy-apply job application flow is configured for those jobs in Recruiting. This
helps candidates complete the application process quickly by answering a few questions. These questions depend on
the configuration of the easy-apply flow.
When the easy apply flow includes the Supporting Documents block, the Recruiting Assistant can also generate a
work summary based on the candidate's resume. The candidate can then review the work summary and submit their
application directly from the chat bot.

This example illustrates a job that has an easy-apply flow configured. This flow includes the Contact Information,
Supporting Documents, and Review blocks.

1. The candidate searches for the job and clicks the Apply button.
2. The terms and conditions associated with the job are first displayed.
3. When the candidate accept the terms and conditions, they're prompted to enter their name and email address,

according to the configuration in the Contact Information block.
4. They provide these details and they upload their resume. The Recruiting Assistant asks them if a work summary

can be generated using their resume. When the candidate agrees, the key highlights from their work experience are
summarized in the generated work summary.

5. The candidate then proceeds to review the summary, edits it as required and adds it to the job application.
6. On submitting the job application, a code is sent to their email. When they enter the correct code, they can review

their application and complete the application process.

Note:  The work summary stands as a cover letter for the application, along with the resume. It’s also added as an
attachment to the candidate's profile in Recruiting.

Related Topics
• Configure an Easy Apply Flow

• Setup Required for Generating Work Summary
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External Candidates - Get Answers to Questions Using AI Assist  
When reviewing a job requisition, candidates might have questions about it. The Recruiting Assistant converses with the
candidate and uses AI Assist to answers these questions, thus increasing the chances of the candidate applying for the
job. Candidates can also ask general and policy-related questions about the company they're interested in.

By answering job-specific questions, the Recruiting Assistant increases the interview acceptance rate and helps
candidates make informed decisions.

When candidates search for jobs, they see the Questions button on the job card. Clicking this button enables them to
ask job-specific questions such as:

• What's the job description?

• What’s the education level required for the job?

• What’s the job location?

• What are the shift timings?

• What’s the job summary?

• What qualifications are required for the job?

• What are the job responsibilities?

• Skills required for the job

• Which organization is the job for?

Candidates can also ask general and policy-related questions about the company, if the answers are configured by the
Administrator.

AI Assist retrieves the answers to job and company-related questions and provides the relevant responses, depending
on the configuration.

Note:
• The Recruiting Assistant can answer questions specific to jobs only when the candidate starts the process by

clicking the Questions button on a job card.

• Candidates can ask questions about a company either before or after a specific task, such as searching for a
job or checking the application status. However, if they ask for this information in the middle of the task, the
Recruiting Assistant won’t return a relevant response.

Internal Candidates  

Internal Candidates - Match Jobs Using Resume  
With the enhanced internal Candidate Experience skill, ICE V2, employees can now view job recommendations based on
their resume.

36



Oracle Fusion Cloud Talent Management
Using and Administering Recruiting Booster

Chapter 5
Use Recruiting Assistant

When searching for jobs, candidates can click the Match Jobs Using Resume button to start the search. The Recruiting
Assistant asks for the candidate's resume and shows relevant jobs based on the skills and job titles in the resume.

To use this feature, you need to complete these prerequisites:

• Enable Attachments in the Chat Interface

• Enable the Profile Import Partner Service

Intended user: Internal candidate (employees)

Sample phrases to use:

• Match using resume

• Find jobs based on resume

• Jobs using resume

Internal Candidates - Ask Questions About the Job and Company  
Employees can now get more information about a job requisition by asking questions about the location of the job,
skills and qualifications required for the job, and so on. They can also ask general and policy-related questions about the
company they're interested in.

To view answers to job requisition questions, the employee needs to have the Access Internal Candidate Experience
(IRC_ACCESS_INTERNAL_CANDIDATE_EXPERIENCE_PRIV) privilege.

When employees search for jobs, they see the Questions button on the job card. Clicking this button enables them to
ask job-specific questions such as:

• What's the job description?

• What’s the education level required for the job?

• What’s the job location?

• What are the shift timings?

• What’s the job summary?

• What qualifications are required for the job?

• What are the job responsibilities?

• Skills required for the job

• Which organization is the job for?

Note:  At any time during the question-and-answer process, employees can apply for the job by entering a phrase
such as “I’m ready to apply”.

Employees can also ask general and policy-related questions about the company on these topics, if the answers are
configured by the Administrator in the Oracle Digital Assistant platform:

• Continuous Education Policy

• International Work Policy

• Parental Leave Policy
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• Vacation Policy

• Visa and Green Card Sponsorship

• Yearly Vacation Policy

• Sick Leave Policy

• LGBTQ Rights

• Diversity

Employees don’t require any privileges to view answers to these company-related questions.
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6  Configure Recruiting Booster

Opt in to Recruiting Booster  
To enable Recruiting Booster and its functionalities, you first need to opt in to Recruiting Booster.

Before you start
You need these privileges to opt in:

• Review Applications Offering

• Configure Oracle Fusion Applications Offering

Here's what to do

1. In the Setup and Maintenance work area, select the Recruiting and Candidate Experience offering.
2. Click Change Feature Opt In.
3. On the Opt In: Recruiting and Candidate Experience page, enable Recruiting Booster.
4. Click Done.

Recruiting Booster Setup and Maintenance Tasks  
Complete these setup tasks to align the configuration with your Hiring business process.

Task Name Description Recommended Help

Hiring Event Registration Flows Task to set up one or more registration flows for
hiring events, which recruiters will select from
when creating new events.

Create Event Registration Flows

Hiring Event Lookups Task to create event categories to group
different types of events. For example, you
could have categories for university hiring
events, campus hiring events, diversity hiring
events.

Create Event Categories Using Lookups

Hiring Events Enablement on External Career
Sites

Task to configure which external career sites will
show events. After you've enabled events for a
career site, event teams can post events to the
career site and candidates who visit the career
site will use the keyword search to find events.

Enable Events on External Career Sites

Hiring Event Privileges Task to assign event privileges to existing
or new user roles for viewing and managing
events that they’re part of.

Assign Event Roles and Privileges

Hiring Event Related Notifications Task to modify the default content of the
seeded Hiring Event notifications. You can
create multiple notifications within a seeded
notification category based on your business

Configure Event Related Notifications
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Task Name Description Recommended Help

needs, but only one among the multiple
notifications can be active at any point of time.

Hiring Events Index and Initial Ingest Task to run the scheduled process called ESS
Job to create index definition and perform
initial ingest to OSCS. This ensures that all
hiring events that either already exist in the
application or those that will be newly created
are fully indexed for search.

Set Up Hiring Events

Hiring Event Success Metrics Task to configure the default number of days
for the Applied Within and Hired Within success
metrics that display on the event overview
page.

Configure Event Success Metrics

Configure Recruiting Assistant Task to configure job and application display
settings, job search settings, and skill
configuration settings to synchronize synonym
data.

Configure Recruiting Assistant

Configure Synonyms for Recruiting Assistant Task to configure job category, job function,
 and location synonyms in the Recruiting
Assistant.

Configure Synonyms for Recruiting Assistant

Synchronize Data with Recruiting Digital
Assistant

Task to synchronize synonym data with
Recruiting Assistant. This synchronizes
location, job category, and job function
synonyms.

Sync Synonym Data with Recruiting Assistant

Configure Easy Apply Flow Task to configure the easy apply flow that
allows candidates to apply for jobs directly from
the Recruiting Assistant interface.

Configure an Easy Apply Flow

Enable Easy Apply Flow Task to enable the easy apply flow after it's
configured.

Enable the Easy Apply Flow

Email Notifications for SMS Replies from
Candidates

Task to configure the email notifications that
are sent when candidates send SMS replies to
the hiring team. You can configure whom to
notify on the hiring team and when to notify
them.

Set Up Email Notifications for Candidate SMS
Replies

Resume Parsing Resume parsing is included in Recruiting
Booster. Your organization might want to use
partner services for parsing candidate’s resume
uploaded during the application process.

Log a Service Request (SR) under the “Oracle
Fusion Recruiting Booster Cloud Service” SKU
for appropriate routing.

Security Reference
The tasks that people can do and the data that they can see depend on their roles, duties, and privileges. For
information about these factors, see these two guides:

• Securing HCM

• Security Reference for HCM
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Scheduled Processes for Recruiting Booster  
Scheduled processes are available for specific business needs in Recruiting Booster. You can schedule and run
processes in the Scheduled Processes work area (Tools > Scheduled Processes).

Process Name Description Recommended Frequency

Process Recruiting Inbound Message Reads and processes incoming SMS messages. Every 15 minutes

Publish Recruiting Events Publishes or unpublishes the events that
are scheduled with a start date set for on or
before the current time. It also sends update
notifications to the event audience and alert
notification to event interviewers (shortlisting
form).

Every 15 minutes

Sync Data with Recruiting Digital Assistant Synchronizes the job location, job category,
 and job function synonyms with the Recruiting
Assistant.

Once a day

ESS Job to create index definition and perform
initial ingest to OSCS
Specify “fa-hcm-irc-hiring-events” in the Index
Name to Reingest field.
 

This ensures that all hiring events that either
already exist in the application or those that will
be newly created are fully indexed for search.
 

During initial setup of Hiring Events, or as
required.

Enable RChilli for Resume Parsing  
The RChilli resume parsing partner is automatically provisioned for Recruiting Booster. Once the partner enablement is
done, you can view the RChilli for Booster on the Profile Import Partners page (in the Recruiting Category Provisioning
and Configuration task). You don't need to enter a service request and upload a zip file to activate RChilli.

Before you start
If you already have a resume parsing partner activated, you'll need to deactivate the languages supported by RChilli
before being able to activate RChilli for Booster.

Here's what to do

1. In the Setup and Maintenance work area, go to:

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Recruiting and Candidate Experience Management

◦ Task: Recruiting Category Enablement

2. On the Partner Enablement page, go to the Profile Import section and click the Configure RChilli for Booster
button.

3. On the Edit Profile Import partner: RChilli for Booster page, select a data center. All the required fields are
automatically filled.

4. Click Save and Close.
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Results:
The RChilli for Booster appears on the Partner Enablement page and its status is Active.
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7  Configure Hiring Events

Set Up Hiring Events  
You can set up hiring events for your organization so that users can create and manage hiring events aimed at building
talent pipelines and bolstering your organization's brand image. Once you've completed the steps below, users with the
necessary privileges have access to the Events tab in Hiring.

1. Create Event Registration Flows
2. Create Event Categories Using Lookups
3. Enable Events on External Career Sites
4. Assign Event Roles and Privileges
5. Configure Event Related Notifications
6. Run the scheduled process called ESS Job to create index definition and perform initial ingest to OSCS. This ensures

that all hiring events that either already exist in the application or those that will be newly created are fully indexed
for search. Specify “fa-hcm-irc-hiring-events” in the Index Name to Reingest field.

7. Configure Event Success Metrics

Related Topics
• What are scheduled processes?

• Configure Event Location Search

Create Event Registration Flows  
You create event registration flows that will be used in hiring events. When recruiters create events, they can choose a
flow from the registration flows you created.

You can activate multiple event registration flows. You can also create multiple versions of an event flow to adapt the
flows to your business needs. The creation process is similar to other flows, except that you need to select the Event
application flow type.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Candidate Experience

◦ Task: Job Application Flow Configuration

2. On the Job Application Flows page, click Create.
3. Enter a name, code, and description for the event.
4. In the Application Flow Type field, select Event.
5. Click Save and Continue.
6. You now need to create versions of the flow and select information blocks for that particular version of registration

flow.
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7. Optionally, add the Event Registration Questions block to the Event Registration Questions section. This feature
lets you gather more information from the event registrants prior to events, and lets you automatically reject
candidate registrations based on the responses provided for disqualification questions.

8. Select the One page registration flow check box if you want this flow to appear to candidates on one page.
9. Activate the flow.

Related Topics
• Create an Event

• Format an Event

• Create an Application Flow

Create Event Categories Using Lookups  
You create event categories to group different types of events. For example, you could have categories for university
hiring events, campus hiring events, diversity hiring events.

Events need to be assigned to categories. Categories that have been assigned to events should not be deleted. By
default, these two categories are available:

• University Hiring (ORA_UNIVERSITY_HIRING)

• Diversity Hiring (ORA_DIVERSITY_HIRING)

1. In the Setup and Maintenance work area, go to:

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Recruiting and Candidate Experience Management

◦ Task: Recruiting and Candidate Experience Lookups

2. On the Recruiting and Candidate Experience Lookups page, search for the lookup type
ORA_IRC_REC_EVT_CATEGORY.

3. In the Lookup Codes section, click the Actions menu to create categories.
4. Create categories.
5. Add the display sequence for the category you created, and ensure it's enabled
6. Click Save and Close.

Enable Events on External Career Sites  
You need to configure which external career sites will show events. After you've enabled events for a career site, event
teams can post events to the career site and candidates who visit the career site will use the keyword search to find
events.

Before you start
The external career site must be using the Minimal template.

Here's what to do
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1. In the Setup and Maintenance work area, go to:

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Candidate Experience

◦ Task: Career Sites Configuration

2. On the Career Sites Configuration page, click Edit next to an external career site.
3. On the General tab, select the Enable events option from the Events section.

Assign Event Roles and Privileges  
You need to assign roles and privileges to existing or new user roles so that they can view or manage the hiring events
that they’re part of.

Aggregate Roles
These roles must be assigned to users so that they can use hiring events.

• View Recruiting Event (ORA_IRC_VIEW_RECRUITING_EVENT): Allows event team members to view all aspects
of the event.

◦ They can select the Events tab and view events they're part of as creator or collaborator.

◦ They can't perform any action or change events. Actions are hidden.

• Manage Recruiting Event (ORA_IRC_MANAGE_RECRUITING_EVENT): Allows event team members to change all
aspects of the event such as dates, locations, and invite candidates to the event.

◦ They can select the Events tab and view events they're part of.

◦ They can create, and update events they're part of. All event actions are available.

Super User Roles
Having super user permissions will allow designated users to perform a wide range of critical tasks efficiently and with
greater flexibility.

• View All Recruiting Events (ORA_IRC_VIEW_ALL_RECRUITING_EVENTS): Allows users to view all recruiting
events.

• Manage All Recruiting Events (ORA_IRC_MANAGE_ALL_RECRUITING_EVENTS): Allows users to manage all
recruiting events.

Prescreening Question Privileges
Grant these privileges to event users so they can add a set of questions to the event registration flow.

• ◦ HRT_REST_SERVICE_ACCESS_QUESTIONNAIRE_LOVS_PRIV

◦ PER_REST_SERVICE_ACCESS_HCM_COUNTRIES_LOV_PRIV

◦ IRC_VIEW_CANDIDATE_JOB_APPLICATION_PRIV

◦ IRC_MANAGE_JOB_REQUISITION_QUESTIONNAIRE_REQUEST_PRIV
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Related Topics
• Overview of Securing Oracle HCM Cloud

Configure Event Related Notifications  
Event related notifications are available in the Recruiting Content Library. Except for the Event Pool Member
Notification, all other notifications are predefined notifications.

You can use the default content of the predefined notifications as a starting point, and change that content to create
multiple notifications based on your business needs. If you've created multiple notifications within a predefined
notification category, note that only one among the multiple notifications can be active at any point of time.

• Event Canceled Notification: Notification sent to candidates to inform them that the event for which they
registered has been canceled. You should configure the notification prior to canceling an event.

• Event Pool Member Notification: Notification sent to event audience to update them about various event
activities. You should configure the notification prior to sending messages to event audience members.

• Event Thank You Notification: Notification sent to candidates to thank them for registering to an event. You
should configure the notification prior to posting an event so that candidates receive the notification once they
register to the event.

• Event Update Notification: Notification sent to candidates to inform them that the event for which they
registered has been updated. You should configure the notification prior to updating an event.

• Send Event Invite Notification: Notification sent to candidates to invite them to register for an event. You should
configure the notification prior to inviting candidates to an event.

Related Topics
• Recruiting Content Library

Configure Event Success Metrics  
You can configure the default number of days for the Applied Within and Hired Within success metrics that display on
the event overview page. These metrics display after an event has started.

Any changes you make here affect only new events going forward.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Recruiting and Candidate Experience Management

◦ Task: Enterprise Recruiting and Candidate Experience Information

2. Expand the Events section.
3. Click Edit and update the metrics according to your organization's needs.
4. Click Save and Close.
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Related Topics
• Event Success Metrics
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8  Configure Candidate Interviews

Set Up the Coordinate Interviews Work Area  
As an administrator, you can configure the display of the tabs in the Coordinate Interviews work area using Transaction
Design Studio.

1. Activate a sandbox and page editing at the Site layer in Settings and Actions Menu > Edit Pages > Activate a
sandbox.

2. On your Home page, go to My Client Groups > Quick Actions > HCM Experience Design Studio.
3. Click the Transaction Design Studio tab.
4. Select the action Recruiting - Coordinate Interviews.
5. Click Add to create a rule.
6. In the Basic Details section, enter a name and description for the rule.
7. In the Page Attributes section, select the Recruiting - Coordinate Interview region.
8. Set the sections to Visible or Not visible.
9. Click Save and Close.

Configure the Visibility of the Interviewers' Availability
Interview Schedule Setting  
As an administrator, you can create a rule in Transaction Design Studio to configure the visibility of the "Candidates
schedule based on interviewers' availability" setting available for candidate-managed interview schedules.

When you configure the field as being visible, the "Candidates schedule based on interviewers' availability" setting
becomes available. When the setting is selected on a schedule, the Meeting Duration and Interviewers fields will also be
available.

1. Activate a sandbox and page editing at the Site layer in Settings and Actions Menu > Edit Pages > Activate a
sandbox.

2. On your Home page, go to My Client Groups > Quick Actions > HCM Experience Design Studio.
3. Click the Transaction Design Studio tab.
4. Select the action Recruiting - Create Interview Schedule.
5. Click Add to create a rule.
6. In the Basic Details section, enter a name and description for the rule.
7. In the Page Attributes section, select the Settings region.
8. Set the “Candidates schedule based on interviewers’ availability” to Visible or Not visible. By default, it is visible.
9. Click Save and Close.
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Add a Shared Interview to a Job Requisition Template  
As an administrator, you can add a shared interview schedule to job requisition templates. The interview schedule is
added automatically to a new job requisition being created from this job requisition template.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Job Requisitions

◦ Task: Job Requisition Templates

2. On the Job Requisition Templates page, open a job requisition template.
3. Click the Interviews tab.
4. Click Add.
5. Select a shared interview schedule.
6. Click Save.

Notifications for Candidate Interviews  
Notifications are sent to different stakeholders during the candidate interview process. The notifications listed below are
specific to Recruiting Booster.

The following notifications used in Recruitng Booster are available in Alerts Composer. As an administrator, you can use
them as is or configure them.

• Interview Availability Notification to Interviewer: Notification sent to the interviewer requesting to define their
availability for upcoming interviews.

• Interview to be Scheduled Request: Notification sent when a request to schedule an interview has been
assigned to a user.

Note:  It’s recommended to not change the recipient token InterviewerUserName in notifications sent to requisition
owners (recruiters and hiring managers). Despite the token referring to the interviewer, the notification does go to
different recipients as explained in each notification description. Changing the recipient could result in unintended
outcomes, like recipients getting duplicated notifications.

The token InterviewSlotsMode is available for these Alerts Composer notifications. Possible values are: AUTO and
MANUAL. With this token, you can use groovy expressions in the notifications to provide additional or different content
depending if the schedule is using Office 365 Calendar availability or not.

• ◦ Interview Schedule With Low Number of Available Openings (IRC_Intrv_Schedule_Low_Openings)

◦ Interview Schedule With No Available Openings (IRC_Intrv_Schedule_No_Openings)

◦ Shared Interview Schedule With Low Number of Available Openings
(IRC_Shared_Intrv_Schedule_Low_Openings)

◦ Shared Interview Schedule With No Available Openings (IRC_Shared_Intrv_Schedule_No_Openings)
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9  Configure Two-Way Candidate Messaging

Configure Two-Way Candidate Messaging  
You configure two-way candidate messaging so that recruiters and hiring managers can have conversations with
candidates using email, SMS, or both.

Recruiters and hiring managers can create an email or text message to start a conversation with an external or internal
candidate about their job applications, interviews, job offers, or have any casual conversation with them. A Messages
tab is available in candidate job applications, prospect records, candidate profiles, candidates in candidate pools. The
tab contains two sections:

• Emails

• Text Messages

Before you start
Opt in to Recruiting Booster

Here's what to do

1. Set Up Two-Way Email Communications
2. Set Up Two-Way SMS Communications
3. Run the Scheduled Process for Inbound Messages
4. Set Up Email Notifications for Candidate SMS Replies

Set Up Two-Way Email Communications  
You set up two-way email messaging so that recruiters and the hiring team can have conversations with candidates
using email.

Before you start

Enable Vanity Email

• Vanity Email is a pre-requisite for enabling two-way communication. Along with Vanity Email, you must also
set up the No Reply Email, which will be used to send Job Alerts, Campaign Emails, and Candidate Verification
Emails (with PIN).

• We use a dedicated vanity email box to route all the messages from and to candidates. This email box
will increase in size over time. If you want to delete emails after they're read, use the Delete read email
messages option in the Email Messaging Provider setting.

Here's what to do

1. Create an Email Messaging Provider
2. Enable Two-Way Communication for Email
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3. Create the Profile Option to Read Email Messages from a Given Start Date

Create an Email Messaging Provider  
You need to create an email messaging provider and activate it.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Recruiting and Candidate Experience Management

◦ Task: Recruiting Messaging Configuration

2. On the Recruiting Messaging Configuration page, in the Email Communications section, click Add.
3. Enter a name and description.

The user name of the active email messaging provider must be the same as the vanity email.
4. If you want to delete emails after they're read, select the Delete read email messages option.
5. Select an authentication type:

◦ Basic Authentication

◦ OAuth

6. Based on the authentication type you selected, enter the required info:

◦ Basic Authentication: Capture the details from your email service provider: IMAP Server, IMAP Port, User
Name, Password. Note: If you're an Office 365 user, use OAuth authentication. Basic authentication for
Office 365 is deprecated.

◦ OAuth: Email Provider, IMAP Server, IMAP Port, Grant Type, Scope, Tenant ID, Authentication URL, Client
ID, Client Secret, User Name. To use the two-way email messaging capabilities with an Office 365 mailbox,
you need to register an application in Azure AD and set up a service principal in Exchange to enable the
application to access Exchange mailboxes via client credentials flow with the IMAP protocol. For details,
refer to the technical brief Set Up OAuth for Office 365 Users (ID 2936718.1) available on My Oracle Support.

7. Click Check Connection to make sure that the configuration is properly done.
8. Click Save and Close.
9. On the Recruiting Messaging Configuration page, in the Email Messaging Providers list, locate the provider you

added and set it to Active.
Only one email messaging provider can be Active at a time.

Related Topics
• Two-Way Candidate Messaging - Set Up OAuth for Office 365 Users

Enable Two-Way Communication for Email  
You enable two-way communication for email and decide if you want to enable it for external candidates, internal
candidates, or both.
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1. In the Setup and Maintenance work area, go to:

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Recruiting and Candidate Experience Management

◦ Task: Recruiting Messaging Configuration

2. On the Recruiting Messaging Configuration page, select these options:

◦ Enable Two-Way Email Communications with External Candidates if you want to enable two-way
messaging with external candidates.

◦ Enable Two-Way Email Communications with Internal Candidates if you want to enable two-way
messaging with internal candidates.

Create the Profile Option to Read Email Messages from a Given
Start Date  
You need to create a profile option called IRC_2_WAY_EMAIL_LAST_SYNC_TIME to read email messages from a given
start date. It represents the last time the email messages are read.

1. In the Setup and Maintenance work area, click the Tasks icon.
2. Click Search.
3. On the Search page, search for the task Manage Profile Options.
4. Click the task name.
5. On the Manage Profile Options page, click the Create icon.
6. On the Create Profile Option page, create the profile option by entering these values:

◦ Profile Option Code: IRC_2_WAY_EMAIL_LAST_SYNC_TIME

◦ Profile Display Name: 2 way Email Last Sync Time

◦ Application: Recruiting

◦ Module: Recruiting Common

◦ Description: Define last sync time for two-way email communication feature.

◦ Start Date: Today's date

7. Click Save and Close.
8. You're back on the Manage Profile Options page and the profile option  IRC_2_WAY_EMAIL_LAST_SYNC_TIME is

displayed. You need to enable the profile option at the Site level.
9. On the Manage Profile Options page, go to the Profile Option Levels section.
10.Set the profile option to be enabled and updatable at the Site level.
11. Click Save and Close.
12. You need to set profile value for the profile option IRC_2_WAY_EMAIL_LAST_SYNC_TIME to define from when the

email messages are to be read.
13. In the Setup and Maintenance work area, click the Tasks icon.
14.Click Search.
15. Click the Search icon.
16.On the Search page, search for the task Manage Administrator Profile Values.
17. Click the task name.
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18.On the Manage Administrator Profile Values page, search for the profile option
code IRC_2_WAY_EMAIL_LAST_SYNC_TIME.

19. Set the profile value to Current date - 1 using the UTC time in standard ISO 8601 format: YYYY-MM-DD HH:MM:SS.
20.Click Save and Close.

Set Up Two-Way SMS Communications  
You set up two-way SMS messaging so that recruiters and the hiring team can have conversations with candidates
using SMS.

Before you start
Two-way communication with SMS currently works with Twilio and Syniverse providers only. Make sure that the proper
provider setup is done before you enable two-way communication. For two-way SMS communication to work correctly,
you need to have a long code number that supports accepting incoming messages.

Here's what to do

1. Create an SMS Messaging Provider
2. Enable Two-Way Communications on Active SMS Messaging Provider
3. Configure the Profile Option to Read SMS from a Given Start Date

Create an SMS Messaging Provider  
You need to create and activate a messaging provider that will be used for communicating with candidates using SMS.

Before you start
Two-way communication with SMS currently works with Twilio and Syniverse providers only. Make sure that the proper
provider setup is done before you enable two-way communication.

Here's what to do

1. In the Setup and Maintenance work area, go to:

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Recruiting and Candidate Experience Management

◦ Task: Recruiting Messaging Configuration

2. On the Recruiting Messaging Configuration page, in the SMS Communications section, click Add.
3. Enter a name and description.
4. Select a provider.
5. Based on the provider you selected, enter info in the Request Details, Authentication, Headers, and Body sections.

For more information, see the document Examples of Adding an SMS Provider on My Oracle Support (ID 2657006.1).

Note:  For processing outbound messages, the SMS messaging provider's API is expected to return the response
in JSON format. To ensure smooth processing of these messages, we recommend that you include the Accept
header in the Headers section and specify its value as application/json.

6. Click Test Outbound Message to send a test message and make sure that the configuration is properly done.
7. Click Save and Close.
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8. On the SMS Messaging Providers list, set the provider you added to Active.

Related Topics
• Examples of Adding an SMS Provider

Enable Two-Way Communications on Active SMS Messaging
Provider  
You need to enable the two-way SMS communications feature.

Before you start
At least one SMS provider needs to be Active to have SMS Communications with the candidate. The phone number that
you use for two-way communications must support incoming SMS messages.

Here's what to do

1. On the Recruiting Messaging Configuration page, select the option Enable SMS Communications.
2. Open the new provider you created, and select the option Enable Two-Way SMS Communications.
3. Click Test Inbound Message to make sure that the configuration is properly done.
4. Click Save and Close.

Configure the Profile Option to Read SMS from a Given Start Date  
You can create a profile option called IRC_2_WAY_SMS_LAST_SYNC_TIME to read SMS messages from a given start
date. It represents the last time the SMS messages are read. This set up step is optional.

1. In the Setup and Maintenance work area, click the Tasks icon.
2. Click Search.
3. On the Search page, search for the task Manage Administrator Profile Values.
4. Click the task name.
5. On the Manage Administrator Profile Values page, search for the profile option

code IRC_2_WAY_SMS_LAST_SYNC_TIME.
6. Set the profile value using the UTC time in standard ISO 8601 format: YYYY-MM-DD HH:MM:SS.
7. Click Save and Close.

Set Up Email Notifications for Candidate SMS Replies  
Here are the prerequisites and steps to set up email notifications when candidates send SMS replies:

Before you start

Ensure that you've set up two-way SMS communications.
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Consider the following info while setting up email notifications:

• You must use a business phone number that supports two-way messaging and not use a short code number.

• This feature currently works with Twilio and Syniverse providers only.

• It’s recommended to set the default value in the profile option ORA_IRC_2_WAY_SMS_LAST_SYNC_TIME as five
days. Note that for Twilio, if you add more than 400 days, it will default to 400 days.

Here's what to do

1. Configure Webhook in the service provider's account.
2. Configure settings for email notifications.

Configure Webhook for SMS Service Providers  
You must configure Webhook in the SMS service provider's account to establish a Webhook connection between
Recruiting and the SMS service provider. To do so, follow these steps:

1. Create a job role in Recruiting.
2. Add the following functional privilege to it:

◦ Name: Use REST Service - Inbound SMS Webhook

◦ Code: IRC_REST_SERVICE_ACCESS_INBOUND_SMS_WEBHOOK_PRIV

3. Create a user account for the SMS provider, and add the job role to the account.
The user account that’s set up to access Webhook must not have any other privileges or roles associated to it, except
the job role that you just created.

4. Apply security roles by running these scheduled processes:

◦ Import User and Role Application Security Data

◦ Retrieve Latest LDAP changes

5. Configure the Webhook functionality in the active SMS provider's account. For details, see the document Service
Provider Setup for Two-Way SMS Communications on My Oracle Support (ID 2936718.1).

Related Topics
• Create Roles in the Security Console

• Two-Way Candidate Messaging - Service Provider Setup for Two-Way SMS Communications

Configure Email Notification Settings for Candidate SMS Replies  
When candidates send SMS replies to the hiring team, you can configure whom to notify on the hiring team and when
to notify them.

1. In the Setup and Maintenance work area, go to:

◦ Setup: Recruiting and Candidate Experience

◦ Functional Area: Recruiting and Candidate Experience Management

◦ Task: Recruiting Messaging Configuration

2. In the Hiring Team Notification for Text Message Replies section, click Edit.
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3. Decide if you want to notify everyone who had an active SMS conversation with the candidate. You can include
recruiters, hiring managers, or both, for job-application or prospect-based active conversations.
When anyone sends a message from the candidate profile or candidate pools pages, they will receive an email
notification when the candidate replies to their message. It isn't affected by the choices you make using this option.

4. Enter the maximum number of days an SMS conversation between a candidate and a hiring team member is
considered active. For example, let’s say you specify 20 days. If a hiring team member sent an SMS to a candidate in
the last 20 days, and the candidate replied to it, an email notification will be sent to all those hiring team members
who initiated a conversation with the candidate during this active conversation period. Also, if you choose to notify
recruiters and hiring managers, they will receive an email notification if they are a part of a requisition that’s related
to the active conversation.
The default value for this setting is 15 days and is configured in the seeded profile option
ORA_IRC_INBOUND_SMS_ACTIVE_CONVERSATION_PERIOD.

5. Enter the number of hours within which a reply received from a candidate is considered for sending an email
notification. For example, let’s say you specify 120 hours. If a candidate’s reply SMS is received within this timeframe
and is processed by the scheduled process, an email notification will be sent to the hiring team. Let’s say the
candidate sent an SMS message before 120 hours and it was missed during the previous Webhook sync. In this
scenario, when the scheduled process runs next time, it'll bring the SMS message into the application, but won’t
trigger an email notification to the hiring team because the reply received from the candidate was before 120 hours.
It’s recommended to keep the number of hours setting shorter and lesser than the maximum number of active
conversation days. The default value for this setting is 120 hours and is configured in the seeded profile option
ORA_IRC_INBOUND_SMS_NOTIFICATION_PERIOD.

6. Click Save.

Related Topics
• Set Profile Option Values

Run the Scheduled Process for Inbound Messages  
You need to run the Process Recruiting Inbound Message scheduled process with a 15-minute frequency to see
candidates' SMS and email replies.

1. From the navigation menu, go to Tools > Scheduled Processes
2. On the Overview page, click Schedule New Process.
3. On the Schedule New Process page, click the menu and select Search.
4. Search for the Process Recruiting Inbound Message process.
5. Click OK.
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10  Configure Recruiting Assistant

Set Up Recruiting Assistant  
You set up Recruiting Assistant to help internal and external candidates find the right jobs, answer their questions, view
recommended jobs, apply for jobs and check their job application status.

Before you start
To use these capabilities in Recruiting Assistant, you must configure the FADigital Assistant and the Candidate
Experience V2 Digital Assistant and also download the corresponding skills available in them.
To set up and configure the FADigital Assistant, refer to the Configure the Digital Assistant chapter of the Using Oracle
Digital Assistant to Interact with HCM guide and complete all of the configuration steps listed there.

To set up and configure the Candidate Experience V2 skill, refer to the Configure the Candidate Experience Skill section
and complete all of the configuration steps listed there.

In addition, perform these steps to set up the Recruiting Assistant for Recruiting Booster:

Here's what to do

1. Configure an Easy Apply Flow
2. Enable the Easy Apply Flow

Configure an Easy Apply Flow  
Candidates can apply to certain jobs directly in the Recruiting Assistant when an easy-apply job application flow is
configured.

Candidates can experience the easy-apply feature only on those job openings that have this job application flow
configured. When they apply for the job, the extent of information they need to provide depends on this configuration.

As an administrator, you configure an easy-apply flow from the Setup and Maintenance work area:

• Setup: Recruiting and Candidate Experience

• Functional Area: Candidate Experience

• Task: Job Application Flow Configuration

The easy-apply flow must include a minimum of one block or a maximum of five blocks from this list:

Section Block Appears in Conversation

Personal Information Contact Information
 
Profile Import
 

Yes
 
No
 

Job Application Questions Job Application Questions Yes
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Section Block Appears in Conversation

More About You Supporting Documents Yes

Summary Review No

Of these blocks, the Contact Information and Review blocks are required. If you add more blocks, candidates will be
redirected to the career site for applying.

During the chat bot conversation, only the Contact Information, Job Application Questions, and Supporting Documents
blocks are displayed, if they're included in the easy-apply flow.

After the easy-apply flow is configured, the recruiter then needs to add it to the job requisition. They do this from the
Detail  >  Configuration section of the job requisition.

As an administrator, you can also add the easy-apply flow to the job requisition template from the Setup and
Maintenance work area:

• Setup: Recruiting and Candidate Experience

• Functional Area: Job Requisitions

• Task: Manage Job Requisition Templates

Related Topics
• Sections and Blocks Used in Job Application Flows

• Info About Job Requisition Template Fields

• Info About Job Requisition Fields

Enable the Easy Apply Flow  
When you opt in to Recruiting Booster, the easy-apply feature is enabled in Recruiting Assistant by default. Use this
procedure to disable or enable it, when required.

1. Go to the Setup and Maintenance work area.

◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Recruiting Assistant

◦ Task: Manage Recruiting Assistant Configuration

2. On the Configure Recruiting Assistant page, select or clear Enable Easy Apply.

Related Topics
• Configure an Easy Apply Flow
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Set Up Answers for Internal Candidate Questions  
The Recruiting Assistant answers employee questions about a job or organization by using specific intents that are
available in the enhanced ICE V2 skill.

Job-related Questions

Questions about a job are answered using the intents in this table. These intents retrieve the responses from the
corresponding job requisition fields. Ensure that you enter the required information in these fields so that the question
intents can query these fields and provide correct responses:

Question Intent Job Requisition Field

Job Corporate Description Question Employer Description

Job Education Level Question Education Level

Job Location Question Primary Location, Other Locations, Primary Work Location, Other Work Locations

Job Qualifications Question Qualifications for Internal Candidates

Job Responsibilities Question Responsibilities for Internal Candidates

Job Shift Question Job Shift

Job Skills Question Skills

Job Summary Question Short Description for Internal Candidates

Job Type Question Job Family

Job Organization Question Recruiting Organization Description

Company-related questions

To answer general and policy-related questions about your organization, you can add your responses directly to these
intents in the ICE V2 skill:

• Continuous Education Policy Questions

• Diversity Questions

• International Work Policy Questions

• LGBTQ Rights Questions

• Parental Leave Policy Questions

• Vacation Policy Questions

• Visa and Green Card Sponsorship Questions

• Yearly Vacation Policy Questions

• Sick Leave Policy Questions

Note:  You must have a subscription to the Oracle Digital Assistant platform to do this task.
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Related Topics
• Create a Job Requisition

• Info About Job Requisition Fields

Use AI Assist to Answer External Candidate Questions  
You can answer external candidate questions regarding job requisitions or the company using Oracle’s AI Assist, which
is powered by Generative AI. As a recruiter, you need to define information about the job requisition or company using
the features available in Recruiting. AI Assist then retrieves the answers from these sources and displays the responses.

• To answer candidate questions about the company, provide the relevant information using the Configure
Recruiting Assistant task.

• To answer candidate questions regarding job requisitions, define the answers either in the job requisition
sections or in Descriptive Flex Fields (DFFs).

Here’s how AI Assist works to answer job-related questions:

1. If you’ve provided the answer in the job requisition, AI Assist retrieves the information using the corresponding
question intent and answers the candidate.

2. If it doesn’t find an answer in the job requisition, it searches for this information in the requisition DFFs and
provides the answer.

3. If it doesn’t find an answer using DFFs, it searches for the information in the Response to Candidate Questions
section in the Configure Recruiting Assistant task and tries to answer the questions.

4. If it doesn’t find a response from any of the above sources, it responds with a message that it couldn’t find an
answer.

For generic, company-related questions, AI Assist looks for information only in the Configure Recruiting Assistant
task, as company-related intents are disabled.

To enable AI Assist to answer candidate questions, complete these prerequisites:

1. Set the language on the career site to English.
2. Create the Profile Option for AI Assist.
3. Configure the Profile Option for AI Assist.
4. Set Up Answers for Job Requisition Questions.
5. Set Up Answers for Company-Related Questions.

Set Up Answers for Company-Related Questions  
To respond to candidate questions about the company, you must provide the relevant answers using the Configure
Recruiting Assistant task.

Company-specific generic intents are no longer used to retrieve answers to company-related questions.

Note:  Although these intents are disabled, they continue to exist in the skill. So, you can copy the company-specific
answers present in the intents and use them in the Configure Recruiting Assistant task.

Here’s how to enter company-related information:

1. Go to the Setup and Maintenance work area.
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◦ Offering: Recruiting and Candidate Experience

◦ Functional Area: Recruiting Assistant

◦ Task: Configure Recruiting Assistant

2. Expand the Responses to Candidate Questions section. Add generic and policy-related information about the
company. The maximum number of characters allowed is 10,000.

Note:  We recommend that you enter the information using multiple paragraphs, with each paragraph
covering a specific topic. We also recommend that you include relevant keywords in the first sentence of the
paragraph to identify the topic, and provide detailed information in the rest of the paragraph. For example,
for information about health and safety policies, start the paragraph with “Our company implements several
health and safety policies.” and then provide the details about the policies in the subsequent sentences. The
first sentence of the paragraph needs to end with either a period or a colon.

3. Click Save and Close.

Note:  Avoid including job-specific information in this task because AI Assist looks for this information in the job
requisition first and then the DFFs.

Set Up Answers for Job Requisition Questions  
To answer questions related to job requisitions, AI Assist uses intents as well as Descriptive Flex Fields (DFFs). So, you
can define answers either in the job requisition sections or in DFFs. Depending on the candidate’s question, AI Assist
will retrieve the response from one of these sources and answer them.

As a best practice, follow these tips to get the best out of AI Assist:

• Provide detailed information in the requisition sections, because AI Assist looks for information in in these
sections first.

• If you need to provide any information other than what's available in the requisition fields, create DFFs. It’s a
best practice not to duplicate information between the requisition and DFF.

• DFF labels should use the full term about a question that a candidate might ask. For example, to create a DFF
for including certification information, create the DFF label as “Certification” and not “Cert”.

If you’re defining answers in the job requisition, enter them in these requisition fields so that AI Assist can use the
corresponding question intents to get the answers:

Question Intent Job Requisition Field

Job Education Level Question Education Level

Job Location Question Primary Location, Other Locations, Primary Work Location, Other Work Locations

Job Qualifications Question Qualifications for External Candidates

Job Responsibilities Question Responsibilities for External Candidates

Job Shift Question Job Shift

Job Skills Question Skills

Job Summary Question Short Description for External Candidates
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Question Intent Job Requisition Field

Job Type Question Job Family

The following job-specific intents are disabled. Therefore, enter answers relevant to them in these sources:

Question Intent Enter Information In

Job Corporate Description Question DFFs

Job Organization Question Configuring Recruiting Assistant task

Related Topics
• Info About Job Requisition Fields

• Add Job Requisition Flexfields to Job Details Pages in Career Sites and Agency Portals

Enable Attachments in the Chat Interface  
When candidates search for jobs using their resume, they need to be able to upload their attachments. This can be done
using the Attachment icon in the chatbot widget. As an administrator, you can enable this icon using HCM Experience
Design Studio. In addition, you can configure other settings such as specifying custom colors and icons, choosing a
layout and theme, and other functionality for the chatbot interface.

To enable the Attachment icon, follow these steps:

1. Enable a sandbox and then edit your pages at the site level.
2. Go to My Client Groups  > Quick Actions  > HCM Experience Design Studio.
3. Click Digital Assistant Configuration from the side menu.
4. From the Digital Assistant list, select the name of the digital assistant you want to configure.
5. Specify the server URL of the digital assistant instance.
6. Specify the Web channel ID of the digital assistant.
7. Select the Share attachment in chat window check box.
8. Click Save and Close.

Results:
The Attachment icon appears on the chatbot interface.

What to do next
To configure other settings and functionality on the chatbot interface using HCM Experience Design Studio, see the
related topic below.

Related Topics
• Configure the Oracle Digital Assistant Interface
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Setup Required for Generating Work Summary  
These prerequisites must be completed to generate a work summary for candidates based on their resume using AI
Assist capabilities.

1. The job requisition must have the easy-apply flow configured. This flow must include the Supporting
Documents block, with the resume and cover letter marked as required.

2. The candidate must attach the resume in the Recruiting Assistant as part of the job search or easy apply
process.

As an administrator, you must complete these steps:

1. Create the Profile Option for AI Assist.
2. Configure the Profile Option for AI Assist.
3. Set the site language to English.

Create the Profile Option for AI Assist  
To use AI Assist to generate the work summary for candidate resumes and to answer their questions related to the
company and job requisition, you must first create the profile option, HCM_GENAI_IRC_ODA_ENABLED.

1. In the Setup and Maintenance work area, click the Tasks icon.
2. Click Search.
3. Search for the task, Manage Profile Options.
4. Click the task name from the search results.
5. On the Manage Profile Options page, click the New icon.
6. On the Create Profile Option page, create the profile option by entering these values:

◦ Profile Option Code: HCM_GENAI_IRC_ODA_ENABLED

◦ Profile Display Name: Enable AI Assist

◦ Application: Recruiting

◦ Module: Recruiting Common

◦ Description: Enable AI Assist for generating work summary and answering candidate questions.

◦ Start Date: Today's date.

7. Click Save and Close.

What to do next
Enable the profile option HCM_GENAI_IRC_ODA_ENABLED at the site level and set up Recruiting Assistant to access the
profile option value.
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Configure the Profile Option for AI Assist  
After you create the profile option HCM_GENAI_IRC_ODA_ENABLED, you must enable it at the site level and set up
Recruiting Assistant to access the profile option value.

Enable the Profile Option  
1. In the Setup and Maintenance work area, click the Tasks icon.
2. Click Search.
3. Search for the task, Manage Administrator Profile Values.
4. Click the task name from the search results.
5. On the Manage Administrator Profile Values page, search for the profile option code,

HCM_GENAI_IRC_ODA_ENABLED.
6. Set the profile value at the Site level to Y.
7. Click Save and Close.

Enable Recruiting Assistant to Access the Profile Option  
1. In the Setup and Maintenance work area, search for the task Manage Profile Categories.
2. Click the task name from the search results.
3. Search for the category, ORA_FND_ANON_REST_ACCESS.
4. In the ORA_FND_ANON_REST_ACCESS: Profile Options section, click the New icon.
5. Select the profile name HCM_GENAI_IRC_ODA_ENABLED from the list.
6. Click Save and Close.

Generate and Download a QR Code  
As a recruiter, you can generate and download the QR code using the Recruiting QR Codes page.

Before you start
To access the Recruiting QR Codes quick action and page, you need the privilege, Manage Recruiting QR Codes having
the privilege code, IRC_MANAGE_RECRUITING_QR_CODES_PRIV. This privilege is granted to the recruiter and hiring
manager roles by default.

Here's what to do

1. Go to My Team or My Client Groups. Click Quick Actions > Show More > Recruiting QR Codes.
2. Click Create.
3. Enter a short code to identify the QR code. This code shouldn't have spaces or special characters.
4. Enter a descriptive name for the QR short code.
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5. In the Site URL field, enter the URL of the filtered list of jobs from the Candidate Experience site.
The site code is noted from this URL.

6. Enter the validity period of the QR code. By default, it’s valid for one month from the validity start date.

The jobs related to the QR code are displayed in the Recruiting Assistant only during this validity period.

7. Click Save and Close.

Results:

A URL with a short code is generated based on the short code name that you entered and the site code.

The Recruiting QR Codes page lists the QR short codes and short code names, along with the site code displayed below
them. Click the Download icon corresponding to the QR short code. This downloads the QR code image, which you can
then publish. When candidates scan the QR code, this URL launches the Candidate Experience page, with the Recruiting
Assistant displaying a greeting message and the list of jobs that pertain to the QR code.

Manage QR Codes  
Using the Recruiting QR Codes page, you can download QR codes, edit their site URL and validity period, and delete
them.

From this page, you can search for the QR code details that you want to edit by entering the short code, short code
name, or site code in the search field. You can also use the filters to search for QR codes based on their creation date,
validity period, or the name of the person who created them.

From the list of QR codes displayed on this page, click a QR short code name. The View QR Code Details page appears,
from where you can edit or download the QR code.

The following considerations apply to deleted and expired QR codes and those with a validity period starting in the
future:

• Any downloaded or published QR code becomes invalid.

• If a candidate scans the QR code, the Candidate Experience page still appears with the Recruiting Assistant
open. However, instead of displaying a list of jobs, the candidate is presented with options to search for jobs.
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